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8/2/24- Ruby

== August 2, 2024 Ruby Thomas

Yesterday was a very busy day but it was very rewarding. To start the day, we had our video interviews
with Paul. I was not excited about this but I prepared well so I didn’t have to redo any of the interview
questions. I was glad because I wanted to do it as quickly as possible. After that, we walked to the Union
to set up for the symposium. I brought my laptop to show our prototype and a lab phone that we
deployed the Unity version on. I really enjoyed the symposium because we got to finally show off all of
the work we’ve done this summer. Some of my favorite parts were getting to show our project to other
people involved with CommHEAT, seeing how people liked interacting with our prototype and Unity
build, and Eliot saying that our app design was beautiful. Apparently he does not say that often so it
really means a lot, especially as someone who worked on the design a lot! By the end of the symposium, I
was really tired but felt so fulfilled! Later that night, after a lot of rest, we had a bonfire with almost all
of the interns, Anjali and her dog and boyfriend, and Paul. The place we had it at was really pretty and I
had lots of fun watching the stars!

This morning, we just had to fill out surveys and do a focus group where we shared our opinions on the
summer. Later, we have our goodbye lunch and then we’ll go back to the apartments and start packing
and cleaning.

Here are some more pictures from yesterday:
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7/30/24- Ruby

E= July 30, 2024 Ruby Thomas

Last night, I just worked on our paper a little bit and watched a movie. I had a meeting for a club 'm
involved with at home where we were planning things for the first few weeks back on campus. I liked
getting to see everyone after not seeing them for so long!

This morning, most of us worked in Howe near the windows so we could watch the storm come in and
enjoy the cool sounds. After, we had a luncheon lecture from a professor in psychology that does
research on decision-making during plea deals. Her presentation was really interesting because she
talked about why certain people take plea deals, but it was also really sad because of how many people
suffer due to the faults in the justice system.

Later today, we have our last formal meeting with Michael and Tian. We are going to go over our poster
presentation and the affinity diagram we finished yesterday.

Here is a picture of a storm I took the other day:
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7/29/24- Ruby

E July 29,2024 Ruby Thomas

This weekend, I chose not to do as much because we had a really busy week last week. Towards the end
of the week , we had to present our projects to students from another REU at CUNY. I thought that it was
fun hearing about their research on Thursday and it was interesting seeing how different their projects
were than ours. For CUNY, they each had to do their own independent research project and they only
had 8 weeks to do it. When we presented, we each had 15 minutes per group. I thought that all of our
groups did really well but the CUNY group didn’t ask very good questions. They only had one or two
questions per group. They asked us if we got to interview any low income residents (which is a fair
question) and how we like ISU (not as good of a question). I'm glad to be done with that because it’s
another deadline crossed off the list. We also finished and submitted our poster for the Symposium this
Thursday. I am really happy with how it turned out and so are Michael and Tian! Now all we have left is
the paper.

This Saturday, I made some Cinnamon Toast Crunch cookies to break up the homework and then went to
Texas Roadhouse with Sophie, Alee, and Andrea for dinner. I love Texas Roadhouse so it was a treat for
me! On Sunday, I finished the first draft of the paper and sent it to Michael and Tian to add comments to
the second half.

This morning, Angy and I worked on revisions from the first half of the paper and Chu Chu worked on
refining the look of the Unity version. I feel like I can finally see the light at the end of the tunnel because
all we have left is some final revisions on the paper!

Here is a picture of the cookies I made:
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7/23/24- Ruby

July 23,2024 = Ruby Thomas

Last night, I took a day off from homework and made a dessert from Ohio called buckeyes. It’s a peanut
butter truffle dipped in chocolate so that it looks like the nut of the buckeye tree. Since we don’t have a
hand or stand mixer, it was a lot of work mixing everything together, but I think they turned out great!
The recipe made about 50 of them, so I brought half of them into VRAC today so people could get a taste
of Ohio. Lydia has been asking me when I was going to make them since I got the ingredients, so she was
excited to see me making them when she got home yesterday.
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This morning, I did the homework for Ethics class that Eliot assigned to us last night and continued
working on the paper. Our luncheon lecture speaker was the Dean of the Graduate College. She gave a
really interesting presentation on all of the resources ISU has for graduate students and some of the
research she has done here. It was really interesting hearing her insight as someone that has a job
helping people through grad school.

Tonight, we are having the highly anticipated pasta-making class with Sarah and Eliot. I am really
excited!

This is what the buckeye dessert looks like:
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7/22/24- Ruby

= July 22,2024 Ruby Thomas

This weekend was pretty fun; on Saturday, we went to mini golf in the evening and then went to El
Azteca afterwards for dinner. I had lots of fun at mini golf! We split into 2 groups to save time, so it was
Andrea, Rodney, Angy, and I on our team. I think we did pretty good and it was funny watching Rodney
and Angy try to beat each other. After, we played a couple of games in the arcade before going to dinner.
I played a couple of rounds of Guitar Hero, which I really like, and a game of MarioKart. Harrison and I
were bummed because neither of their basketball games were working so we couldn’t compete against
each other. We went to El Azteca for dinner, which was really good and well priced! I got a burrito with
steak, chicken, rice, and guacamole. It was huge so I saved half for Sunday. At the end of the night, we
hung out upstairs in the guys’ room and played Mario Party and MarioKart. Sunday was a work and
relax day, so it wasn’t as fun but was definitely needed!

This morning, I made really good progress on the CommHEAT paper. I got pretty much all of the lit
review done and we are now approaching 7 pages. Angy and Chu Chu are working on the outline for the
rest of the paper so it is easier to write.

I don’t have any concrete plans tonight, but we may end up doing something.

Here is a picture I took at the library on Sunday:
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7/19/24- Ruby

= July 19,2024 Ruby Thomas

Last night was lots of fun! We got to learn how to make baklava with Heliya in the food science building.
Their kitchen was super nice and I think we did a great job making the baklava! It was really fun to
make because I like baklava and I've always wondered how it was made. It was really good and tasted
even better because we made it ourselves! Later in the night, we finally finished season 1 of Game of
Thrones! It only took 8 weeks!

Today, I have been working on our research paper. I got lots of comments on the intro that I have been
fixing and I have been reading a lot more papers to fill out the literature review section of the paper. I
am going to continue working on it the rest of the day.

Here is a picture of the baklava we made (credit to Heliya for the cute picture):
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7/18/24- Ruby

July 18,2024 = Ruby Thomas

Last night, I talked to my friends at home for a few hours while we played Minecraft. It was a lot of fun
and I got to talk to some of my friends I haven’t talked to all summer. Later in the night, all of the girls
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got together and hung out and played with some makeup. It was a lot of fun and Harrison and Rodney
joined in a little bit when they stopped by.

This morning, we had an HCI class about interdisciplinary research. It was really interesting for me
because I am always getting asked about how psychology fits into technology. To me, it’s hard to see how
psychology doesn’t fit into technology and HCI, but hearing someone else talk about the benefits of
interdisciplinary research. After, our luncheon lecture speaker was Jack Miller. He went to ISU for his
Bachelor’s, Master’s, and PhD. He works at the Mayo Clinic working in VR and AR. He showed us some of
his projects that he did at VRAC and they were super cool.

This afternoon, we have meetings and work time and after work, we are learning how to make baclava
with Heliya!

Here is another picture, but it is an old picture of my cat, Reese, because I am missing her dearly:
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HCI: Heuristics & Biases

= July 18,2024 Ruby Thomas

« Heuristic/Bias 1: Choice overload- people get overwhelmed when they are presented with many
options.
« Design principle: White Space
» Design in application: Limit the number of choices on one app screen so people are not
overwhelmed with options. Make some assumptions about what the user will like so they don’t
have to decide.
« Heuristic/Bias 2: Status Quo Bias- our preference for the current state of affairs, resulting in
resistance to change.
« Design principle: Repetition
« Design in application: Use icons and designs that look similar to other apps/devices that are
popular. We have been using Google icons so people know what they mean without explaining
them.
» Heuristic/Bias 3: Primacy Effect- The tendency to remember the first piece of information we
encounter better than information presented later on.
» Design principle: Hierarchy
» Design in application: Put the most crucial information at the top of each page so that people
remember the most essential information and do not get distracted by less important features.

"1 Blog Posts [ 1 Reply

7/17/24- Ruby

B2 July 17,2024 Ruby Thomas

Last night, I didn’t do much with the other interns in the evening because I had a long meeting about
marching band back at my university. Since I'm president of the band, I have to have a couple meetings
over the summer to talk to the directors, exec board, section leader, etc. Later into the night, we finished
watching the Elizabeth Holmes documentary for our Ethics class. I wish the one we watched went more
into the legal battle, but it gave us a good understanding of everything leading up to them getting
charged.

This morning, I worked on standardizing the design of our app, while Angy added more screens and Chu
Chu looked over the revisions on the Intro for our paper. After, we had Ethics class with Eliot again,
where we mostly talked about our thoughts on the Elizabeth Holmes/Theranos case. There were lots of
layers to our discussion about respecting talent without liking the person, why people would believe her,
and how her and other people’s actions led to the downfall of Theranos. The rest of the class, we talked
about ethical decisions that are common in business and what usually comes from them.

The rest of today is a work day but we have a meeting with some of the other people involved in
CommHEAT in the afternoon.

Here is a picture of a mural I liked in Des Moines:
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7/16/24- Ruby

== July 16,2024 Ruby Thomas

Last night, some of us went bowling at the Memorial Union, which was a lot of fun. I bowled 111 for both
games and raced Rodney on a MarioKart game. He won but by a hair. At night, we watched some of the
Elizabeth Holmes documentary which we will finish tonight.

This morning, we presented the first drafts of our CUNY presentations. Our team did well but we have
some notes to work on for the actual presentation. After, we had our luncheon lecture with Alex, so it
was really cool to hear more about him! Later this afternoon, we have meetings for our project and work
time.

Here is a picture from last night:
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7/15/24- Ruby

E July 15,2024 Ruby Thomas

This weekend was lots of fun. On Saturday, we started the day early by getting to the Des Moines farmers
market at 10 am. I didn’t buy much, but there was a really cool brass band there that me and Andrea
listened to for a while. Afterwards, we all got food and went to Gray’s Lake to sit on the beach and go in
the water a little bit. I mostly sat on the beach but went in the water up to my knees a couple of times. I
definitely got burnt up, so I am dealing with that now, but I enjoyed it. Overall, it was super hot and
sunny all day, but we still had fun. That night, we went to a park nearby and grilled on one of the
charcoal grills. Rodney, Andrea, and I did most of the grilling. We grilled hot dogs and corn on the cob we
got from the farmers market. Sunday was a nice lazy day, but I did some homework, cleaned, and baked.
I made lemon cupcakes with lemon frosting and brownies to go with the ice cream Lydia and I got. They
were both really good and I made enough to share with the other interns.

Today is crazy hot. I don’t usually mention the weather, but the Real Feel temperature is currently 103
and the UV index is 10 out of 11. This morning, I have been working on our PowerPoint presentation,
abstract for the symposium, and intro for our final paper. I don’t mind writing as much as some of the
other interns because I am used to having to write for school. It is also nice to do academic writing
because I can take a break from the creative thinking needed for designing the app.

Later, we are going to go bowling since it is cheap Sundays and Mondays.


https://projects.vrac.iastate.edu/reu2024/category/uncategorized/
https://projects.vrac.iastate.edu/reu2024/2024/07/15/7-15-24-ruby/
https://projects.vrac.iastate.edu/reu2024/2024/07/15/7-15-24-ruby/
https://projects.vrac.iastate.edu/reu2024/2024/07/15/7-15-24-ruby/
https://projects.vrac.iastate.edu/reu2024/2024/07/15/7-15-24-ruby/
https://projects.vrac.iastate.edu/reu2024/author/rubythms/

Here is a picture of us at the farmers market:
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7/12/24- Ruby

= July 12,2024 Ruby Thomas

Last night, the only thing I really did with other people was work on our app design with Angy. We made
a lot of progress during the day, it apparently our design was t what Tian was looking for so we are
currently working on the redesign.

This morning, I have been working on our paper. While I am doing that, Angy is working on the design
in Figma and Chu Chu is working on the structure of the app in Unity. I think we are working together
well since we have things to do in areas we like. There is not much to talk about since we are all hanging
out less to work on our projects after work.

Tonight we may go bowling and watch some tv if everyone isn’t too busy.

Here is a picture from the inside of the Capitol Building:
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7/10/24- Ruby

E July 10,2024 Ruby Thomas

Now that we are all busy working on our projects, we are having less time to hang after work. So, last
night we didn’t do much but hang out and chat for a little bit before going to bed.

This morning, we started working on a Figma prototype for our CommHEAT app. We decided on some
features and sketches yesterday so we are recreating those in Figma. Chu Chu and Angy are working on
learning app development in Unity while I am refining the design and researching our branding palette
for the app. We have also started writing our paper, which I am taking the lead on since I have written
the most in college.

Later today we will keep chugging away at our tasks and have a meeting with Nick about app
development in Unity.

Here is another picture from Des Moines:
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7/9/24- Ruby

July9,2024 & Ruby Thomas

Last night, we went out as the CommHEAT group for dinner for the first time! Chu Chu had plans, but
Angy, Tian, Michael and I went to Macubana and finally got to talk about stuff outside of our project. I
had a really good chicken bacon ranch grilled cheese, so I thought it was a nice evening out. Later in the
night, I helped Angy dye her hair. I think it looks pretty good and it was definitely fun to do.

This morning, we had our first Ethics class with Eliot. There was a lot of debating and arguing points in
this class. Afterwards, we had our luncheon lecture with Dr. Merate Bakarat. She is in the architecture
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department and does really interesting research in soundscape architecture. I thought it was interesting
how she was talking about the perception of sounds and the different levels of the soundscape.

The rest of the day today we will work at our main projects.

Here is a picture I took while in Des Moines:

il

Polk County Court House
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7/8/24- Ruby

July 8,2024 = Ruby Thomas

This weekend was a lot of fun! Because of the 4th of July, we got a 4 day weekend which was much
needed at this point! Wednesday night, we went to the Ames fireworks display as a group and had an
intern from another program, Max, join us. We had fun exploring the area around the stadium
afterwards as well. On Thursday, we saw Inside Out 2 in the movies (wWhich was great) and got dinner at
Ichiban (which was also great). At night we hung out and did some sparklers in the parking lot! Friday
was a slow day, but I enjoyed having no commitments and getting to chat with some of my friends from
home. I made banana nut muffins, choc chip muffins, and cheddar garlic biscuits. Saturday, some of us
went to downtown Des Moines to visit the farmers market for a little bit and explore the state capital. I
got a bundle of sunflowers from the farmers market, but we didn’t have a lot of time to explore so that’s
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all I got. I think we will try to go back again next weekend. The Iowa state capitol was really impressive
and we took some cute pictures by it. Sunday, we all did our own stuff and one of the other groups went
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out to dinner with their grad mentor. Rodney made a nice homemade dinner with Andrea and Alee’s
help. We didn’t really do much the rest of the night, so I got all of my homework done and made more
banana bread.

This morning, we had a Craft of Research session where we talked about presenting posters and elevator
speeches. I thought it was interesting hearing from the other groups. We were asked to come up with
questions for the other groups. For StemXR: How will you measure the effectiveness of your game in
engaging the students? Will it be qualitative or quantitative methods? For CuriosityEEG: How is the Muse
headband different from the traditional EEG? Do you get the same quality of data or is there a trade off in
quality for the portability of the headband?

Today, we have meetings and work time with our project groups.

Here is a picture from the 4th of July:

BeReal.

Here are pictures of Angy, Lydia, and I from the capitol:
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7/2/24- Ruby

July 2, 2024 Ruby Thomas

Last night was yet another relaxing night. Rodney, Angy, and I stayed at VRAC late, but when I got home
Sophie and I cut up the watermelon I bought at the store. It was really good and some of the others had
some when they came over.
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This morning, we had Intro to HCI where we talked about human error and how software can be biased.
I really enjoyed some of the examples Stephen showed in the lecture. I also really enjoyed learning about
how software developers are starting to design with inclusivity in mind.

This afternoon, we have our project meeting for CommHEAT and then some more work time.

It is super rainy here today (which I don’t mind), so here is a picture of the view:
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7/1/24- Ruby

E July 1,2024 Ruby Thomas

This weekend was a lot of fun! On Saturday, my grandpa and 2 of his sisters came to visit me and bring
me out to lunch. I showed them around VRAC and told them about all of the cool projects we are
working on. We went to lunch at Sweet Caroline’s in downtown Ames and the food was really good. In
the evening, most of us went out to a park and had a small bonfire. We made s’mores, which was really
fun. On Sunday, most of us just did work in the morning and afternoon and then just hung out and
chatted later in the night.

This morning, we worked on our MCA projects more in the 3D printing lab. We are making good
progress and starting to work on our presentation. We all have separate projects but will present as a
group on Wednesday.

Here is a video of Angy dancing by the fire:
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HCI: Research Design Activity

=] June 29, 2024 Ruby Thomas

The hypothetical study I designed related to smart phones and driving safety is testing the safety of GPS
on the phone vs. GPS on the car console. Since the cellphone GPS has more built-in distractions than the
car GPS, this study wants to evaluate how participants drive while using car or cellphone GPS. The
hypothesis for this study is that participants using GPS on their phone will make more mistakes while
driving than those who use the built-in car GPS. To test this, participants will be randomly assigned to
either the phone or car GPS group. The participants will then try to navigate a certain route in a driving
simulator using the GPS. The phone group will have notifications appear randomly while they are
driving. The driving simulator will measure mistakes such as speeding, missing stop signs, and making
wrong turns. The independent variable is the type of GPS used and the dependent variable is number of
driving mistakes. Scores from each group will be compared to see which group made more mistakes
while driving.

Blog Posts 1 Reply

6/27/24- Ruby

=] June 27,2024 Ruby Thomas

Last night was pretty fun because we went swimming like I thought we would, but only me and Rodney
ended up going. After that, I just did work and went to bed.

This morning was a lot of fun! We had a lecture with Stephen about research in HCI and after he was our
luncheon lecture speaker! In the first lecture, he talked about research methods in HCI, which was very
similar to the research methods I have learned for psychology. Afterwards, he told us about his personal
history, current research projects, and his time in Namibia. It was really interesting hearing about how
he got where he is today and he used such a good storyteller. The overall message for his presentation
was that you are not in complete control of your life, but you can work to prepare yourself for
opportunities that may come in the future. Some of the projects he talked about seemed really cool and
was really cool for me to see because they all combined cognition with technology.

Here is another picture:


https://projects.vrac.iastate.edu/reu2024/category/uncategorized/
https://projects.vrac.iastate.edu/reu2024/2024/06/29/hci-research-design-activity/
https://projects.vrac.iastate.edu/reu2024/2024/06/29/hci-research-design-activity/
https://projects.vrac.iastate.edu/reu2024/2024/06/29/hci-research-design-activity/
https://projects.vrac.iastate.edu/reu2024/2024/06/29/hci-research-design-activity/
https://projects.vrac.iastate.edu/reu2024/author/rubythms/
https://projects.vrac.iastate.edu/reu2024/category/uncategorized/
https://projects.vrac.iastate.edu/reu2024/2024/06/29/hci-research-design-activity/#comments
https://projects.vrac.iastate.edu/reu2024/2024/06/29/hci-research-design-activity/#comments
https://projects.vrac.iastate.edu/reu2024/2024/06/27/6-27-24-ruby/
https://projects.vrac.iastate.edu/reu2024/2024/06/27/6-27-24-ruby/
https://projects.vrac.iastate.edu/reu2024/2024/06/27/6-27-24-ruby/
https://projects.vrac.iastate.edu/reu2024/2024/06/27/6-27-24-ruby/
https://projects.vrac.iastate.edu/reu2024/author/rubythms/

(1 Blog Posts

6/26/24- Ruby

June 26,2024 = Ruby Thomas

Last night was not too interesting- I just did some work and went to bed early so I could catch up on
sleep.

This morning, we started working with Alex on our MCA projects! I was able to print a few parts for my
project and got to learn how to use different slicing programs. Angy and Rodney are making some
progress on their projects as well, so that is really cool to see. So far one of the hardest parts about the 3D
printing deeper dive is figuring out different prototypes and finding things to do while they are printing.
So far, all of my parts have taken over an hour each, so I have filled the time with learning more from
Spencer and Alex, doing work for CommHEAT, and seeing what Rodney and Angy are doing.

I am really excited because we finally made plans to go swimming tonight! I have been wanting to go
back for a long time!

Here is a picture of a baby chipmunk I came across:
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6/25/24- Ruby

June 25,2024 & Ruby Thomas

Last night was pretty fun. I got my MCA project pretty much nailed down after talking with Alex for an
hour or so! At home, I talked with my friends from home for a while and then we watched yet another
episode of GoT.

This morning, we had a Craft of Research session about blogging and plagiarism. Yvonne talked about
how it is important for us to blog everyday for a number of reasons and gave us tips on blogging. In the
afternoon, we had lunch with a former REU intern, Holly, who eventually ended up going to ISU for the
HCI masters and is now working in industry. It was really interesting hearing about her experience and
how the program has evolved from then to now. Some of the things that stuck with me were when she
talked about her expectations for the research and how it felt leaving the program. She told us about
how she had expectations for how far the research project would get but then had to adjust as they got
closer to the end of the project. We are only in week 5, but I feel like I will have to do the same. The


https://projects.vrac.iastate.edu/reu2024/category/uncategorized/
https://projects.vrac.iastate.edu/reu2024/2024/06/25/6-25-24-ruby/
https://projects.vrac.iastate.edu/reu2024/2024/06/25/6-25-24-ruby/
https://projects.vrac.iastate.edu/reu2024/2024/06/25/6-25-24-ruby/
https://projects.vrac.iastate.edu/reu2024/2024/06/25/6-25-24-ruby/
https://projects.vrac.iastate.edu/reu2024/author/rubythms/

CommHEAT project description talked about developing an app and doing user testing, but so far all we
have done is reading (which I know is important) so I don’t know how far into prototyping we will get.
She also briefly mentioned the grief that she went through and how weird it felt to go back to undergrad
after this experience. I think that I will feel similar to her since we have all been getting along so well.
Overall, it was a really cool experience to hear from someone that was once in our shoes.

I’'m not sure what we will be doing tonight, but I'm sure we’ll do something.

Here is a picture of the sky from when we were laying out in the sun:
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6/24/24- Ruby

June 24, 2024 Ruby Thomas

This weekend was a lot of fun! We started with going to Flip N Jacks for breakfast on Saturday morning.
Heliya, Harrison, and I all got the same thing but none of us really liked it. After breakfast, we went
thrifting and I found a jacket and 2 shirts! I enjoyed the casual morning and just getting to hang out. On
Sunday, we did work in the morning and then Harrison, Lydia, and I sat out in the sun in the afternoon.
It was pretty hot but it felt really nice! In the evening, we watched another episode of GoT.
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This morning, we learned a lot more about the geometry involved in the 3D printing software. At the end
of the lecture, we were able to pick something small for our first print on the 3D printers! I picked a rat
holding a bowl. It’s only going to be about 7 cm tall, but it is still a really cute design.

Here is a picture of the first few layers of the print:
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6/21/24- Ruby

& June 21,2024 Ruby Thomas

Last night we watched Spirited Away in the big auditorium here in Howe Hall. I already knew I liked the
movie, and it was fun to see the others’ reactions. I think most of us really enjoyed it and we are talking
about also watching Howl’s Moving Castle sometime soon.

Today, we had our first Deeper Dive session. I really enjoyed getting to learn more about 3D printing and
additive manufacturing as a whole. We talked about why 3D printing is sometimes called “rapid
prototyping”- which is because you can create models faster than with traditional methods (rapid) and
those functional models can be used as a prototype (prototyping). We also got a cool demonstration and
explanation of the different parts of the 3D printers as well as an explanation of the hardware that
controls the machines. We also started talking about file types and what you can do with different files.
We learned that while you can convert a CAD file to a STL file, you can’t covert a STL file back to CAD
because the STL file does a process called tessellation. This converts the CAD geometry into a mesh of
triangles, so you would not have the same exact shape if you put it back from STL to CAD.

We will have another Deeper Dive session this afternoon and we are probably going to have a girls night
tonight. We are going to watch a movie, do some crafts, and have some good snacks.

Here is a picture of us (ft. Anjali’s dog) at the movie last night:
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6/20/24- Ruby

== June 20, 2024 Ruby Thomas

Last night was another chill night with homework and some video games. Rodney fried pork chops in
spiced oil that was making their eyes burn, so him and Harrison came to our apartment for a while to
get some fresh air.

Today, we filled out some surveys related to the classes we took and then had our lunch lecture with Dr.
Elizabeth Stegemoller, the faculty mentor for the Curiosity EEG team. It was really interesting hearing
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about her research. Her main area right now is music therapy and singing to help treat symptoms of
Parkinson’s. I really liked the incorporation of music and neuroscience. She is also just really fun to talk

to!
Tonight we will watch Spirited Away in the auditorium, so that will be fun!

Here is a picture from inside the library:
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6/19/24- Ruby

& June 19,2024 Ruby Thomas

Last night, we did Zumba as our extracurricular! I thought it was fun but it was hard for me to match the
instructor’s hands and feet at the same time. I liked getting to be active together and enjoyed the songs
we danced to.

Today, we did more in Unity and eventually made our Blender models into simple, but functional,
games! In my game, you walk around a small amusement park to eat all of the cotton candy you can
find. It is not a complex game, but I am still proud of how quickly we made the game. At the end of the
day, we were assigned our Deeper Dive groups. I am excited because I got put into the 3D Modeling &
Printing group! Alex is our instructor and I got grouped with Rodney and Angelica! I am excited to learn
more and see everyone’s projects!

Tonight, we may go swimming again. I am really enjoying the pool and it’s been a while so I'm hoping it
works out.

Here is a picture of us post-Zumba:
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6/18/24- Ruby

& June 18,2024 Ruby Thomas

Last night was pretty uneventful- I just stayed home and worked on homework. I read an interesting
article about how we must consider all of the meanings, life circumstances, and experiences of users
when designing technology. I also got to see some of the data that the CommHEAT team collected last
year and took some notes on that as well.

Today, we had another craft of research lecture where we talked about the methods, results, and
discussion sections of research papers. I really liked the article Yvonne used as an example. It talked
about how certain balances of warmth and competency in Al teammates affected the reception of the Al
in human teams. This reminded me of the warmth-competency matrix I learned about in my Psych of
Women class, where women in the workplace have to choose warmth or competency to be respected at
work.

Our lunch lecture today was with Eliot, which was nice. I liked getting to know more about his research
since we’ve seen him around a lot but didn’t really know what his background was. Some of the things I
took from his lecture were: 1) In school, it’s not where you go that’s important but who you work with. 2)
Things change rapidly during school so make sure you are ready to adjust. 3) Think about job qualities
you like, not necessarily the job title you want. Overall, I really liked his talk and he is very engaging
when he is telling stories.

Tonight we have a dance fitness class. I am assuming this will be similar to some Zumba classes I have
done in the past, so I think it will be fun to see everyone try their best.

Here is another picture of campus:
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6/17/24- Ruby

June 17,2024 Ruby Thomas

This weekend, we went to the farmer’s market in downtown Ames! It was raining the whole time, but we
still had lots of fun. I got two loaves of bread, a cupcake, and a book from the local bookstore. I enjoyed
getting to talk to the people and get some good food. That night, Harrison, Lydia, and I laid in the grass
and looked at the stars. I made more banana bread last night and had some for breakfast this morning.

Today, we started putting our Blender models into Unity. It’s cool to get to see our models at all angles
and I'm curious what we’ll do later today.

Tonight I think we will watch more Game of Thrones and work on homework.

Here is a picture from our stargazing session and some cats I saw at Petco:
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HCI: Interfaces to Improve

June 16,2024 & Ruby Thomas

Here are two interfaces that I believe need to be improved upon.

1) Hulu My List: One feature that Hulu offers is the “My List” feature. This lets the user add content to
the list so that they can come back and watch the show/movie without having to rely on memory. I think
that this page is well designed visually; I like the rounded shapes and hierarchy created with different
fonts, weights, and brightness. I also like how the preview image for the show is highlighted when you
hover over it. The part that I believe needs to be improved upon is the more info link. In other streaming
services, they have a clear button to let you know how to access more information about the show. In
this area of Hulu, the user is supposed to click on the title of the show to gain more info. However, there
is no signifier that lets the user know that is what they have to do. When you hover over the image, the
title doesn’t change to let you know it is clickable. When you hover over the title, the only thing that lets
you know you can click on the title is that the cursor changes shape. Additionally, with such a small font
size for the title, it is less likely that the user will stumble across the clickable title on accident. To make
this better, I think that there should either be a button on the image, similar to the play button, or the
title should underline when the user hovers over any area of the showcard.
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2) Ebay Shop by Categories: This feature on Ebay allows users to browse items by specific categories.

When the user clicks on the “Shop by category” button, this dropdown menu opens. I like that there is
some visual hierarchy with the bolded text on the broad categories and normal text for the detailed
categories. I also like how there is an arrow next to the broad categories, which lets the user know that

they can click on them to get to another page. However, I think that this dropdown menu has too many

options. With the broad and specific categories, there are over 45 options on this single dropdown. I

think it would be more effective if only the broad categories were showing at first, and the specific

categories show when the broad category is interacted with. This way, the user is not overwhelmed with
options and they can get to the category they need easier.
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6/14/24- Ruby

June 14,2024 & Ruby Thomas

Last night, most of the interns hung out at our apartment and just told stories and gossiped. I liked
getting to know people better and hear some of the funny stories!

Today we are doing even more Blender. I am still finding it difficult, especially because a lot of the
tutorials have a different version with different options and buttons. I have made some simplified
shapes for my project but I still have a lot to go. I am currently writing my blog as we are sitting under
the water tower in the sun

I’'m not sure what we’re doing tonight, but I'm sure we’ll have some fun.

Here is a picture from right now:
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6/13/24- Ruby

June 13,2024 & Ruby Thomas
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Last night, I was really tired after work so I just stayed in the apartment for most of the night and tried to
get work done. Before we went to bed, we did watch some tv, so that was fun.

This morning, we had some work time and then had our first Intro to HCI lecture. We talked a little
about the history of HCI and talked about how important it is to go to conferences in your fields. I liked
learning about all of the different conferences in HCI and might end up going to some of them in the
future. After that, we had a lunch and presentation with Carmen Gomez. She showed us some of her
research making sensors that test for various chemicals in liquids. Some of her work has been used in
the agricultural sector to detect chemicals from fertilizer in fresh produce. While her concepts were
really complex, I thought it was cool how creative some of their solutions were and how many big
organizations she and her team have worked with.

Tonight we will have a game night at VRAC and get some more homework done.

Here is a new picture I took on a morning walk:
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6/12/24- Ruby

June 12,2024 Ruby Thomas
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Last night, we did light painting with Paul in the photo studio! We created some really cool pictures and
had some fun messing around. After that, most of us just did work independently and then we watched
Game of Thrones at night.

Today, we started the day with more Solidworks and put together the parts we made yesterday. I really
enjoyed this because it was like putting together a puzzle! I experimented with some weird textures and
backgrounds after it was assembled. After that, we started working on Blender for the first time. We had
to try making a cat face out of a sphere. I think this went okay but it is definitely harder for me than
Solidworks.

Tonight we will probably all just relax and get some work done.

Here is the finished vice put together in chrome and sponge:
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6/11/24- Ruby

June 11,2024 & Ruby Thomas

Last night, we went to the pool and hung out with one of the interns from another REU, Ezra. We had lots
of fun playing basketball and swimming around in the whirlpool and getting to know each other.

Today, we had another Craft of Research lesson where we talked about literature reviews. I really liked
the template Yvonne gave us. I think it will be really helpful when we have to start writing. After, we got
to learn about Dr. Jon Kelly’s research and have lunch with him. I really really enjoyed his talk because
he was talking about how he uses cognitive and sensory psychology in VR research applications. Today,
he talked a lot about Cyber Sickness, which is when you get sick from being in VR. He explained that this
is because of a mismatch in the visual and non-visual stimuli you get when you’re moving. In VR, your
eyes see that you are moving, but your body does not get any of the sensations you normally get when
moving. This is where the disconnect happens. We also got to talk to him a little about his other research
and some of his other interests. I really enjoyed getting to talk to him.

Later today we have our next project meeting. We will meet with Tian and talk about everything we read
the past week.

Here is what I have been working on in Solidworks:
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6/10/24- Ruby

= June 10, 2024 Ruby Thomas

This weekend, we got up early on Saturday to do some physical bonding exercises and do a high ropes
course. These activities were very intense. We had to pick each other up, Lydia stood on Harrison and
Chu Chu’s shoulders, and lots of people got at least a little sore or injured... Sunday morning, I made
French toast for everyone that was home! I made banana bread the day before so I used that and some
chocolate chip brioche I had in the pantry. That evening, there was a picnic where we got to meet lots of
other REU interns and got some good BBQ!

Today, we started learning Solidworks. I don’t think it is that bad, but the homework we got will
definitely take a little bit of time. To me, this is easier than C++.

Tonight, we are going to go swimming again and some of the interns we met might join us.

Here is another picture I took:
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6/7/2024- Ruby

== June 7,2024 Ruby Thomas

Last night, we went to downtown Ames as a group for the first time this summer. There was an art walk,
where lots of the shops were open later and artists had booths along the sidewalks. While I didn’t find
anything from the artists, they were very talented. There are a lot of really cute shops in downtown
Ames, but they all close around 6 pm or earlier. I hope that we will go back there possibly sometime on
the weekend so we have more time to look around. After visiting Ames, we went out to eat at Buffalo
Wild Wings. I had a really good wrap and it was lots of fun getting to hang out longer.

Today is our last day of C++ lectures. We went deeper into classes and talked about how you can inherit
functions between classes. After our lecture, we went to lunch with our teacher, Nick. This was lots of
fun and there were lots of laughs. Harrison got approached by some kids asking to play truth or dare
and he entertained them for a bit.

Later today, we will have our last lecture on C++ where Nick is going to tell us all of the things he wished
he learned when he was starting C++. Angelica, Chu Chu, and I have had a lot of reading to do in our free
time. I don’t mind it, but I think it is funny to see the other teams collaborating on coding and we are all
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sitting quietly taking notes on research papers. I'm not sure what we are doing tonight, but I wouldn’t
mind a quiet night in.

Here is a picture of us from last night:
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6/6/24- Ruby

= June 6, 2024 Ruby Thomas

Last night was a lot of fun because Harrison, Lydia, Rodney, Chu Chu and I went swimming in the state
gym pool for the first time this summer! We played in the whirlpool, watched Harrison jump of the high
dive a few times, played lots of water basketball, and relaxed in the hot tub a little bit. It’s been a long
time since I’ve been swimming so I had lots of fun and am excited for the next time we go.

This morning, we went around campus with Paul to take pictures for the website. We all got matching
shirts with the vintage mascot to wear for the photo shoot. After we got back, we had our next lunch &
lecture with Dr. Wes Lefferts, who talked about the connection between cardiovascular health and brain
functioning. I really liked how he stressed that his journey was non-linear and that you don’t need to
know exactly what job you want because eventually you will find what you are passionate about. He
also showed us a little bit of how he makes animated anatomical diagrams in PowerPoint. That was
really impressive.
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The rest of today is a work day and then we will go to the Art Walk in downtown Ames tonight.

Here are some pictures from last night:




71 Blog Posts

6/5/2024- Ruby

== June 5,2024 Ruby Thomas

This morning, I took an extra long walk to VRAC since the weather was so nice. I am enjoying getting to
know campus and take pictures.

Today started with more lectures on C++. Today was a little more difficult because the programs are
getting more complex, but I was still able to figure out the challenges after a bit of work. We started
using functions, so the programs are getting much longer.

After work, we are going to try to go swimming, but we will have to see if the pool is open today.

Here is a picture I took on my walk:
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6/4/2024- Ruby

June 4,2024 = Ruby Thomas

Today we started with the 2nd lecture in our Craft of Research series. We were able to work together in
our research teams to come up with short project statements for our respective projects. This will help
us in the future with our writing and it will also help us explain our research to other people. So far, I
am enjoying the craft of research series, but a lot of it is stuff I am already familiar with.

Later in the day, we got to have lunch with Dr. James Oliver. He had lots of great stories about his career
and research where he gave us 3 things to remember: 1) under-promise and over-deliver, 2) don’t be a
wallflower, and 3) imposter syndrome is normal and almost everyone gets it. For me, the most impactful
parts were when he talked about imposter syndrome and his experience with grad school. I thought that
all of his stories were really interesting and there were lessons in each one that we could use to guide us
in the future. Overall, it was a great lunch and even better conversation.

P.S. here is a picture I took in the library when some of us went to study this weekend.
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6/3/2024- Ruby

& June 3,2024 Ruby Thomas

Today is the first day I have ever tried coding in C++. We will be spending the next week having lectures
and working on small projects so that we can (hopefully) be proficient in C++ by the end of the week. So
far, it is not that bad because I have found it similar to Python. I'm guessing it is going to get much more
difficult, but here is our first (very simple) program!
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#include <iostreams
wint main()

int ui;

std: teout << “Please enter number of seconds as a whole number: "
std:tedn »» ul; //user inputs seconds

int uisee;

uisec = (Ul % 68); //calculates seconds

int uimin;

uimin = Cud / 68) % 68; //calculates minutes

int uihour;
uihour = (Cui / 66) / 68) % 60; //calculates hours

//std: :cout << "Hours: ", std::cout << uihour << std::endl; //prints hours
/fstd::cout << "Minutes:®, std::cout << uimin << std::endl; //prints minutes
//std::cout << "Seconds:", std::cout << uisec << std::endl; //prints seconds
std::cout << ui, std::cout << " seconds is ",
std: :cout << uihour, std::cout << * hours, ",
std::cout << uimin, std::cout << " minutes, and ",
std: icout << uisec, std::cout << " seconds.® << std::endl; //prints results sentence

/7 Run program: Ctrl + F5 or Debug > Start Without Debugging menu|
LH Debug program: F5 or Debug > Start Debugging menu
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I . Use the Error List window to view errors
I . Go to Project > Add New Item to create nem code files, or Project > Add Existing Item to add exis
Vi . In the future, to open this project again, go to File > Open > Project and select the .sln file
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